
Комбинирование Деталей и
Поверхностей

Поверхности - ценные элементы, потому что они могут представлять сложные
криволинейные формы. При соединении с параметрической деталью, они срезают
поверхности и заменяют их пространственными поверхностями. Или же поверхности
могут добавлять материал к детали типа выступов. В настоящем учебном пособии, Вы
объедините параметрическое и поверхностное моделирование, создавая тело камеры с
пространственной поверхностью.

Ключевые термины

Термин Определение
base surface

(базовая поверхность)

Основная поверхность, проходящая через большую область. При
необходимости, может быть обрезана, но базовая поверхность
остается нетронутой и может отображаться.

model view

(видовой экран)

Изменяет точку обзора так, чтобы объект рассматривался с
различных позиций. Отдельные виды могут отображаться в
нескольких видовых экранах. Например, введите 3 в командной
строке, чтобы создать три видовых экрана с заданными по
умолчанию видами: сверху, спереди и изометрический вид.

NURBS Аббревиатура для неоднородного рационального В-сплайна.
Команда SPLINE создает истинную кривую NURBS и может
использоваться для создания поверхности.

rail

(направляющая)

Одна или более криволинейных линии, по которым перемещаются
поверхности. Они формируют кривизну из поверхности
протягивания.

Spline

(сплайн)

Криволинейная линия, определенная указанными контрольными
точками, которая принимает уникальную форму. Используется для
создания пространственных поверхностей. Радиус сплайна
непрерывно изменяется. Сплайны используются в качестве
источников поверхностей произвольной формы.

surface cut

(рассечение поверхностью)

Элемент, получаемый при соединении поверхности к детали. Там,
где поверхность отрезает деталь или наращивает материал,
поверхностей детали принимает изогнутую форму. Поверхность,
подобно другим элементам, является параметрической; и
поверхность, и деталь сохраняют параметрические отношения
всякий раз, когда кто либо из них изменяется.

wire

(нить)

Универсальный термин, относящийся к линиям, дугам, кругам,
эллипсам, двух- и трехмерным полилиниям и сплайнам.

work plane Бесконечная плоскость, присоединенная к детали. Может являться
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(рабочая плосоксть) плоскостью эскиза и может быть включена в размерную схему или
схему зависимостей. Рабочие плоскости могут быть
параметрическими или непараметрическими.

work point

(рабочая точка)

Параметрический рабочий элемент, используемый для
позиционирования отверстия, центра массива или любой другой
точки для которой отсутствует геометрическая привязка

Краткий Обзор Урока

Новые особенности в этом уроке

Новые элементы, включенные в эту обучающую программу

• Использование контекстно-зависимых меню для вызова команд

• Использование улучшенного интерфейса командной строки

Дополнительную информацию по новым и улучшенным элементам, см. главу 3, «Новые
элементы» в руководстве «Начинаем работать».

Базовая Концепция Комбинирования Деталей и Поверхностей

Вы можете использовать Mechanical Desktop для создания деталей со скругленными
гранями. Вы можете использовать трехмерные поверхности для таких деталей, чтобы
создать гибридные детали, состоящие из комбинации угловых и изогнутых форм. В
Mechanical Desktop Вы можете создавать модельные конструкции с формами различных
типов.

Вы можете применять поверхности к  деталям Mechanical Desktop и использовать эти
поверхности для срезания материала с параметрической детали, создания любой
комбинированной формы, которой требует ваш проект.

Вы можете также использовать поверхности для добавления материала к угловым
элементам.

Использование Элементов Поверхности
Элемент, созданный из поверхности имеет форму очерченной поверхности. Вы либо
срезаете материал, либо добавляете материал для присоединения его к детали.
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В настоящем учебном пособии, Вы срежете угловые поверхности и замените их
пространственной поверхностью.

Поверхности должны иметь следующие характеристики, которые нужно использовать в
качестве элементов для моделей:

• Очерченная поверхность должна иметь четыре логических границы.

• Изогнутая форма должна быть единственной поверхностью. Если Вам требуется
несколько поверхностей для получения формы, Вы должны соединить их в
отдельную поверхность.

• Поверхностью должна являться необрезанная базовая поверхность. Соединяйте
только базовые поверхности, а не внутренние обрезанные грани обрезанных
поверхностей.

• Поверхность должна выходить за деталь со всех сторон.

• Поверхность не должна иметь острых углов.

• Поверхности должны иметь минимальное число внутренних траекторий. Такие
поверхности работают корректнее и быстрее, чем сложные.

Сначала, сделайте эскиз камеры со всех сторон (виды сверху, сбоку, спереди и
изометрический вид). С таким представлением Вы можете решить, где размещать
элементы на камере

Тело камеры, общее для всех других элементов, является базовым элементом.
Конструкция камеры имеет много других элементов, некоторые из которых –
представляют из себя вырезы в корпусе: отсеки для батареек и пленки и вырез под
крышку; установочные отверстия для ручки взвода и кнопка спуска; отсеки видоискателя
и вспышки. Элемент объектива представляет из себя объемную поверхность,
присоединенную к поверхности камеры.

Откройте файл camera.dwg в папке desktop\tutorial. Файл содержит параметры настройки,
в которых Вы нуждаетесь и геометрию для создания корпуса камеры - элемент
выдавливания и некоторые кривые NURBS. Вы будете использовать NURBS для
создания пространственной поверхности камеры.

ОБРАТИТЕ ВНИМАНИЕ Сделайте резервную копию файлов учебных чертежей, чтобы
Вы имели оригинальные файлы на случай ошибки. См. «Резервное Копирование Файлов
Учебных Чертежей» на странице 7.

Вы можете работать с вашей моделью в любом видовом экране, перемещаясь между
видами по мере создания элементов.
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Сначала, Вы создадите две поверхности протягиванием по направляющей. Затем, Вы
соедините их в отдельную поверхность и расширите поверхность так, чтобы она
охватила весь корпус камеры.

ОБРАТИТЕ ВНИМАНИЕ Если вы предпочитаете использовать пиктограммы для вызова
команд - выберите Surfaced → Launch Toolbar.

Для создания поверхности протягивания
1. Чтобы создавать первую половину поверхности протягивания, выберите один из

следующих методов:

Пиктограмма Swept Surface

Меню Desktop Surface → Create Surface → Sweep

Команда AMSWEEPSF

2. Ответьте на запросы следующим образом:
Select cross Sections: На виде спереди выберите правый горизонтальный сплайн (1)

Select cross Sections: нажмите ENTER

Select rails: Выберите вертикальный сплайн (2)

Select rails: нажмите ENTER

3. В диалоговом окне Sweep Surface (Поверхность Протягивания) укажите:
Orientation: Parallel, затем нажмите OK
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Первая половина поверхности протягивания создана.

4. Создайте вторую половину поверхности протягивания.

Пиктограмма Swept Surface

Меню Desktop Surface → Create Surface → Sweep

Команда AMSWEEPSF

5. Ответьте на запросы следующим образом:
Select cross Sections: Выберите левый горизонтальный сплайн (1)

Select cross Sections: нажмите ENTER

Select rails: Выберите вертикальный сплайн (2)

Select rails: нажмите ENTER

В диалоговом окне Sweep Surface (Поверхность Протягивания) укажите:
Orientation: Parallel, затем нажмите OK

6. Соедините две поверхности.

Пиктограмма Join Surfaces

Меню Desktop Surface → Edit Surface → Join

Команда AMJOINSF

7. Ответьте на запросы следующим образом:
Select Surfaces to join: Выберите правую поверхность(1)

Select Surfaces to join: Выберите левую поверхность (2) и нажмите ENTER

Эти две поверхности составят единую поверхность. Полученная поверхность, вероятно,
не выходит за деталь со всех сторон; поэтому Вы должны удлинить поверхность.

8. Удлините поверхность.

Пиктограмма Lengthen Surface

Меню Desktop Surface → Edit Surface → Lengthen

Команда AMLENGTHEN
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9. Ответьте на запросы следующим образом:
Base Edge=Single Extension=Percent Method=Parabolic Value=110.0000%

Select Surface Edge or [Base Edge/Extension/Method/Value]: Введите v

Enter percent <110.0000%>: Введите 105

Base Edge=Single Extension=Percent Method=Parabolic Value=105.0000%

Select Surface Edge or [Base Edge/Extension/Method/Value]:

Выберите правую вертикальную кромку поверхности  (1)

Base Edge=Single Extension=Percent Method=Parabolic Value=105.0000%

Select Surface Edge or [Base Edge/Extension/Method/Value]: нажмите ENTER

Поверхность сейчас простирается за куб, представляющий корпус камеры

Параметрическое Присоединение Поверхности
Далее, Вы создадите рабочую плоскость и рабочую точку и, затем, размер от рабочей
точки к детали. Этот размер установит параметрическую зависимость между
поверхностью и деталью. Положение поверхности управляется рабочей точкой, а
ориентация управляется рабочей плоскостью, связанной с рабочей точкой. Позже, если
Вы измените положение рабочей точки, положение поверхности изменится
соответственно.

Для облегчения позиционирования рабочей плоскости и рабочей точки, работайте в
изометрическом виде.

Для присоединения поверхности
1. Для создания рабочей плоскости для рабочей точки, выберите один из следующих

методов:

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Work Plane.

Пиктограмма Work Plane

Меню Desktop Design → Work Features → Work Plane

Команда AMWORKPLN

2. В диалоговом окне Work Plane Feature (Элемент Рабочей Плоскости) укажите:
1st Modifier: Planar Parallel

2nd Modifier: Offset

Offset: Введите 1

Create Sketch Plane: Включите переключатель и нажмите OK
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3. Ответьте на запросы следующим образом:
Select work plane, planar face or [worldXy/worldYz/worldZx/Ucs]:

Выберите переднюю поверхность камеры (1)

Enter an option [Next/Accept] <Accept>:

Перебирайте n до подсветки передней поверхности, или нажмите ENTER

Enter an option [Flip/Accept] <Accept>:

Введите f, чтобы стрелка указывала от корпуса камеры, или нажмите ENTER

Plane = Parametric

Select Edge to align X axis or [Z-flip/Rotate] <accept>:

Убедитесь, что Пиктограмма UCS вертикальна и нажмите ENTER

Вы создали параллельную рабочую плоскость со смещением от передней поверхности
детали.

4. Разместите рабочую точку в рабочей плоскости.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Work Point.

Пиктограмма Work Point

Меню Desktop Design → Work Features → Work Point

Команда AMWORKPT

5. Ответьте на подсказку следующим образом:
Workpoint will be Extrude on the current sketch plane.

Specify the location of the workpoint: Укажите положение (2)

Вы создали рабочую точку в плоскости эскиза.

6. Привяжите рабочую точку к корпусу камеры.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

7. Ответьте на запросы  следующим образом:
Select first object: Укажите рабочую точку (3)

Select second object or place Dimension:

Выберите правую кромку корпуса камеры (4)
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Specify Dimension Placement: Разместите горизонтальный размер (5)

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<1.3316>: Введите 1

Solved underconstrained sketch requiring 1 Dimensions or constraints.

(Для определения неопределенного эскиза требуется 1 размер или зависимость)

8. Продолжите в командной строке создание вертикального размера для полного
определения рабочей точки.
Select first object: Выберите рабочую точку

Select second object or place Dimension:

Выберите нижнюю кромку корпуса камеры

Specify Dimension Placement: Разместите вертикальный размер

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<0.8898>: Введите 1

Solved fully constrained sketch.

Select first object: нажмите ENTER

Сохраните ваш файл.

Разрезание Деталей Поверхностями
Теперь, когда поверхность закоординирована относительно корпуса камеры, Вы можете
использовать ее для срезания материала с плоской поверхности камеры.

Для срезания материала с детали
1. Создайте рассечение поверхностью с использованием одного из следующих методов:

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Extrude Features  → Surface Cut.

Пиктограмма Surface Cut

Меню Desktop Design → Extrude Features  → Surface Cut

Команда AMSURFCUT
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2. Ответьте на запросы следующим образом:
(Type: Cut)

Select Surface or [Type]: Выберите поверхность

Select work point: Выберите рабочую точку

Specify portion to reMove: [Flip/Accept] <Accept>:

Убедитесь, что стрелка указывает от детали и нажмите ENTER

Одна сторона детали срезается, оставляя криволинейную поверхность. Вы видите
измененный корпус и сплайны по которым создавалась поверхность.

3. Регенерируйте чертежные виды.

Меню Desktop View → REGENALL

Команда REGENALL

4. Удалите три сплайна, по которым Вы создавали поверхность.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Erase.

Пиктограмма Erase

Меню Desktop Modify → Erase

Команда ERASE

Выберите три сплайна, и нажмите ENTER.

Сохраните ваш файл.
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Создание Элементов Выдавливания
Отсек для пленки в задней части базового элемента имеет две элемента: отсек и
крышку.

Задняя часть камеры - плоская. Вы определите ее как плоскость эскиза, выполните
профиль и выдавите его прямо в корпус камеры.

Для создания эскиза отсека для пленки
1. Создайте новую плоскость эскиза.

Обозреватель Щелкните правой кнопкой мыши на заднем плане и выберите New
Sketch Plane.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите New Sketch Plane.

Пиктограмма New Sketch Plane

Menu Desktop Part → New Sketch Plane

Команда AMSKPLN

2. В изометрическом виде ответьте на запросы следующим образом:
Select work plane, planar face or [worldXy/worldYz/worldZx/Ucs]:

Выберите заднюю поверхность камеры (1)

Enter an option [Accept/Next] <Accept>:

Перебирайте n до подсветки задней поверхности или нажмите ENTER

Plane = Parametric

Select Edge to align X axis or [Z-flip/Rotate] <accept>:

Выберите нижнюю кромку камеры (2)

Plane = Parametric

Select Edge to align X axis [Z-flip/Rotate] <accept>:

Укажите, чтобы ось X указывала влево и нажмите ENTER

Задняя часть камеры теперь определена, как плоскость эскиза. В изометрическом виде
пиктограмма UCS отображается с осью X, направленной влево.

Далее, измените вид, чтобы видеть заднюю часть камеры. Если необходимо, измените
масштаб изображения, чтобы увидеть заднюю часть камеры целиком.
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3. Перейдите от вида спереди к виду сзади.

Пиктограмма Back View

Меню Desktop View → 3D Views → Back

4. Выполните эскиз прямоугольника на левой половине задней части камеры.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и выберите
2D Sketching → Rectangle.

Пиктограмма Rectangle

Меню Desktop Design → Rectangle

Команда RECTANG

5. Создайте профиль из эскиза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Single Profile.

Пиктограмма Single Profile

Меню Desktop Design → Sketch Solving → Single Profile

Команда AMPROFILE

Вам потребуется разместить четыре размера или зависимости: два - для определения
размера эскиза и два - для определения местоположения эскиза на корпусе камеры.

Для добавления размеров и привязки к эскизу отсека для пленки
1. Образмерьте ширину прямоугольника.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

2. Ответьте на запросы следующим образом:
Select first object: Выберите нижнюю горизонтальную линию эскиза (1)

Select second object or place Dimension: Укажите положение (2)

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<3.7546>: Введите 4

Solved underconstrained sketch requiring 3 Dimensions or constraints.

(Для определения неопределенного эскиза требуется 3 размера или зависимости)
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3. Определите высоту прямоугольника.
Select first object: Выберите левую вертикальную линию эскиза (3)

Select second object or place Dimension: Укажите положение (4)

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<3.7546>: Введите 2.5

Solved underconstrained sketch requiring 2 Dimensions or constraints.

Select first object: нажмите ENTER

4. Сделайте активным изометрический вид.

 Чтобы видеть размеры и эскиз профиля более четко, поверните изометрический вид,
пока не увидите заднюю часть камеры.

Пиктограмма Left Back Isometric View

Меню Desktop View → 3D Views → Back Left Isometric

5. Привяжите прямоугольник к корпусу камеры.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

Определите расстояние между верхней частью эскиза и задней частью камеры.
Select first object: Выберите линию (1)

Select second object or place Dimension: Выберите линию (2)

Select second object or place Dimension: Укажите положение (3)

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<3.7546>: Введите .1626

Solved underconstrained sketch requiring 1 Dimensions or constraints.

(Для определения неопределенного эскиза требуется 1 размер или зависимость)

6. Определите расстояние между правой частью эскиза и правой задней кромкой камеры.
Select first object: Выберите линию (4)

Select second object or place Dimension: Выберите линию (5)

Select second object or place Dimension: Укажите положение (6)

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]
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<3.7546>: Введите .8426

Solved fully constrained sketch.

Select first object: нажмите ENTER

Затем, вырежьте отсек для пленки в корпусе камеры.

Для вырезания отсека для пленки
1. Используйте элемент выдавливания для вырезания отсека для пленки в корпусе камеры.

Обозреватель Щелкните правой кнопкой мыши по Profile2 и выберите Extrude.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Extrude.

Пиктограмма Extrude

Меню Desktop Part → Sketched Features → Extrude

Команда AMEXTRUDE

2. В диалоговом окне Extrusion (Выдавливание) укажите:
Operation: Cut

Termination: Blind

Distance: Введите 1.2

Flip: Укажите направление стрелки внутрь корпуса камеры

Нажмите ОК.
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Вырезанный отсек отображается во всех четырех видах.

3. Активизируйте и затем восстановите видовые экраны в первоначальную ориентацию.

Верхний правый видовой экран: Изометрический вид спереди справа

Нижний левый видовой экран: Вид спереди

Вырезание крышки подобно вырезанию отсека для пленки. Вы сделаете эскиз
прямоугольника на правой стороне камеры и сделаете глухое выдавливание в корпус
камеры.

Для создания эскиза крышки отсека пленки
1. Создайте новую плоскость эскиза.

Обозреватель Щелкните правой кнопкой мыши на заднем плане и выберите New
Sketch Plane.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите New Sketch Plane.

Пиктограмма New Sketch Plane

Menu Desktop Part → New Sketch Plane

Команда AMSKPLN

2. В изометрическом виде ответьте на запросы следующим образом:
Select work plane, planar face or [worldXy/worldYz/worldZx/Ucs]:

Выберите боковую поверхность камеры (1)

Enter an option [Accept/Next] <Accept>:

Подсветите боковую поверхности и нажмите ENTER

Plane = Parametric

Select Edge to align X axis or [Z-flip/Rotate] <accept>:

Укажите, чтобы ось Z  указывала от камеры и нажмите ENTER
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3. Установите начало координат UCS в левый нижний угол правой части камеры.

Desktop Menu Assist → New UCS → Origin

4. Ответьте на запросы следующим образом:
Specify new origin point <0,0,0>: Введите end

of: Укажите точку в левом нижнем углу бокового вида

ОБРАТИТЕ ВНИМАНИЕ Если пиктограмма UCS не появилась в левом нижнем углу
камеры, установите системную переменную AutoCAD UCSICON в On.

5. На виде сбоку, увеличьте поверхность камеры.

Контекстное Меню В графической области щелкните правой кнопкой мыши и
выберите Zoom.

Пиктограмма Zoom

Меню Desktop View → Zoom → Realtime

6. Удерживая левую кнопку мыши увеличьте изображение и, затем, нажмите ENTER для
завершения команды.

7. Создайте эскиз прямоугольной формы для выреза под крышку.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и выберите
2D Sketching → Rectangle.

Пиктограмма Rectangle

Меню Desktop Design → Rectangle

Команда RECTANG
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8. Создайте эскиз профиля.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Single Profile.

Пиктограмма Single Profile

Меню Desktop Design → Sketch Solving → Single Profile

Команда AMPROFILE

Вам потребуется четыре размера или зависимости для определения эскиза. Добавьте
зависимости, которые определяют положение профиля на стенке камеры.

Для наложения зависимостей на крышку отсека для пленки
1. Добавьте коллинеарные зависимости к эскизу.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Collinear.

Пиктограмма Collinear

Меню Desktop Design → 2D Constraints → Collinear

Команда AMADDCON

Сделайте нижний край эскиза профиля коллинеарным с нижней строкой отсека пленки.

2. Ответьте на запросы следующим образом:
Valid selection(s): line or Spline segment

Select object to be reoriented: Выберите линию (1)

Valid selection(s): line or Spline segment

Select object to be made collinear to: Выберите линию  (2)

Solved underconstrained sketch requiring 3 Dimensions or constraints.

(Для определения неопределенного эскиза требуется 3 размера или зависимости)

3. Сделайте правую часть профиля коллинеарной с правой кромкой корпуса камеры.
Valid selection(s): line or Spline segment

Select object to be reoriented: Выберите линию (3)

Valid selection(s): line or Spline segment

Select object to be made collinear to: Выберите линию  (4)

Solved underconstrained sketch requiring 2 Dimensions or constraints.

(Для определения неопределенного эскиза требуется 3 размера или зависимости)
Valid selection(s): line or Spline segment

Select object to be made collinear to: нажмите ENTER

Enter an option
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4. Образмерьте ширину и высоту прямоугольника.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

5. Ответьте на запросы следующим образом:
Select first object: Выберите горизонтальную кромку профиля

Select second object or place Dimension: Разместите горизонтальный размер

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<0.6840>: Введите .6

Solved underconstrained sketch requiring 1 Dimensions or constraints.

Select first object: Выберите вертикальную кромку профиля

Select second object or place Dimension: Разместите вертикальный размер

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<2.3218>: Введите 2.5

Solved fully constrained sketch.

Select first object: нажмите ENTER

Горизонтальный размер делает ширину профиля равной половине глубины отсека
пленки, а высота профиля равняется высоте отсека.

Для практики, задайте ширину и высоту профиля в виде уравнения.

Для вырезания крышки отсека для пленки
1. Вырежьте профиль из корпуса камеры.

Обозреватель Щелкните правой кнопкой мыши по Profile3 и выберите Extrude.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Extrude.

Пиктограмма Extrude

Меню Desktop Part → Sketched Features → Extrude

Команда AMEXTRUDE

2. В диалоговом окне Extrusion (Выдавливание) укажите:
Operation: Cut

Termination: Blind

Distance: Введите .1574

Flip: Укажите направление стрелки внутрь корпуса камеры
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Нажмите ОК для создания элемента выдавливания, затем сохраните ваш файл.

Отсек для батарей также имеет вырез для крышки. Порядок создания этих элементов не
имеет значения, но естественная последовательность состоит в том, чтобы сначала
создать отсек.

Вырез для отсека батарей более сложен из-за его формы. Особенность создания этого
элемента заключается в правильном расположении плоскости эскиза на левой нижней
стороне корпуса камеры.

ПРИМЕЧАНИЕ Проследите, чтобы пиктограмма UCS находилась в изометрическом виде
и лежала в нижней части камеры.

Для создания эскиза отсека для батарей
1. Перейдите от вида сверху к виду снизу.

 Пиктограмма Bottom View

Меню Desktop View → 3D Views → Bottom

2. Создайте новую плоскость эскиза в изометрическом виде.

Обозреватель Щелкните правой кнопкой мыши на заднем плане и выберите New
Sketch Plane.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите New Sketch Plane.

Пиктограмма New Sketch Plane

Menu Desktop Part → New Sketch Plane

Команда AMSKPLN

3. Ответьте на запросы следующим образом:
Select work plane, planar face or [worldXy/worldYz/worldZx/Ucs]:

Выберите нижнюю поверхность камеры (1)

Plane = Parametric

Select Edge to align X axis or [Z-flip/Rotate] <accept>:

Укажите, чтобы ось Z  указывала вниз от корпуса камеры

Enter an option [Accept/Next] <Accept>:

Укажите, чтобы ось Х указывала влево и нажмите ENTER
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4. В виде снизу сделайте эскиз профиля отсека батареи на основании корпуса камеры.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Polyline.

Пиктограмма Polyline

Меню Desktop Design → Polyline

Команда PLINE

5. Используйте опцию Arc/Direction (Направление Дуги) команды PLINE для отрисовки
второй дуги.

6. Создайте профиль.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Single Profile.

Пиктограмма Single Profile

Меню Desktop Design → Sketch Solving → Single Profile

Команда AMPROFILE

Эскизу требуется от семи до девяти размеров или зависимостей, в зависимости от того,
насколько точно Вы нарисовали эскиз. Если Вам требуется более семи зависимостей, Вы
должны добавить некоторые отсутствующие геометрические зависимости.

Для наложения зависимостей на батарейный отсек
1. Рассмотрите текущие геометрические зависимости.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Show Constraints.

Пиктограмма Show Constraints

Меню Desktop Part → 2D Constraints → Show Constraints

Команда AMSHOWCON
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2. Добавьте все отсутствующие зависимости для геометрического объекта.

Обычно, радиусные (R) зависимости и одна зависимость касательности (T)  отсутствуют
у дуг.

ОБРАТИТЕ ВНИМАНИЕ Когда Вы добавите зависимости, форма эскиза может
исказится, но Вы сможете восстановить ее по завершении образмеривания.
Образмерьте самый большой вертикальный размер и дуги перед образмериванием
небольших объектов.

3. Завершите эскиз, добавляя следующие размеры.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

Для вырезания отсека для батарей
1. Вырежьте профиль из корпуса камеры.

Обозреватель Щелкните правой кнопкой мыши по Profile4 и выберите Extrude.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Extrude.

Пиктограмма Extrude

Меню Desktop Part → Sketched Features → Extrude

Команда AMEXTRUDE

2. В диалоговом окне Extrusion (Выдавливание) укажите:
Operation: Cut

Termination: Blind

Distance: Введите 2.4

Flip: Укажите направление стрелки внутрь корпуса камеры
Нажмите ОК.
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Вырез крышки отсека для батарей расположен в той же плоскости, что и отсек батарей.
Поэтому, Вам потребуется только создать и наложить зависимости на прямоугольник,
вырезав его в корпусе камеры на требуемую глубину.

Для создания эскиза и наложения зависимостей на крышку отсека для батарей
1. На виде снизу сделайте профиль выреза.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и выберите
2D Sketching → Rectangle.

Пиктограмма Rectangle

Меню Desktop Design → Rectangle

Команда RECTANG

2. Создайте профиль.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Profile.

Пиктограмма Profile

Меню Desktop Design → - Sketch Solving → Profile

Команда AMPROFILE

Эскиз требует четырех размеров или зависимостей.

3. Привяжите эскиз к основанию корпуса камеры.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Tangent.

Пиктограмма Tangent

Меню Desktop Design → 2D Constraints → Tangent

Команда AMADDCON

Выберите линии, которые формируют внешние кромки эскиза, коллинеарные с внешними
кромками корпуса камеры.

4. Образмерьте длину и ширину профиля.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

5. Ответьте на запросы  следующим образом:
Select first object: Выберите узкую сторону прямоугольника

Select second object or place Dimension: Разместите горизонтальный размер

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<0.7463>: Введите .76

Solved underconstrained sketch requiring 1 Dimensions or constraints.
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Select first object: Выберите длинную сторону прямоугольника

Select second object or place Dimension: Разместите вертикальный размер

Enter Dimension value or [Undo/Hor/Ver/Align/Par/aNgle/Ord/Diameter/pLace]

<1.1274>: Введите 1.3

Solved fully constrained sketch.

Select first object: нажмите ENTER

Эскиз полностью определен.

Для выреза крышки батарейного отсека
Вырежьте место под крышку в корпусе камеры. Убедитесь, что направление выреза
указывает в корпус камеры.

Обозреватель Щелкните правой кнопкой мыши по Profile5 и выберите Extrude.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Extrude.

Пиктограмма Extrude

Меню Desktop Part → Sketched Features → Extrude

Команда AMEXTRUDE

2. В диалоговом окне Extrusion (Выдавливание) укажите:
Operation: Cut

Termination: Blind

Distance: Введите .1574

Flip: Укажите направление стрелки внутрь корпуса камеры

Нажмите ОК.

Сохраните ваш файл.
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Создание Отверстий
И кнопка спуска, и ручка взвода монтируются в расточенных отверстиях, которые Вы
создадите как типовые элементы.

Для создания отверстий под кнопку спуска и ручку взвода
1. Перейдите в левом верхнем видовом экране к виду сверху.

Пиктограмма Top View

Меню Desktop View → 3D Views → Top

2. Увеличьте вид до требуемого размера и, затем, активизируйте изометрический вид.

3. Разместите отверстия для кнопки спуска и взвода пленки.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Extrude Features  → Hole.

Пиктограмма Hole

Меню Desktop Design → Extrude Features  → Hole

Команда AMHOLE

4. В диалоговом окне Hole (Отверстие) укажите:
Operation: C’bore

Termination: Blind

Placement: 2 Edges

Drill Size: Dia: Введите .5

Depth: Введите 1.0

PT Angle: Введите 180

C’Bore/Sunk Size: C’ Dia: Введите .65

C’Bore/Sunk Size: C’ Depth: Введите .1

Нажмите ОК.
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5. Ответьте на запросы следующим образом:
Select the first Edge: Выберите верхнюю заднюю кромку на изометрическом виде (1)

Select the second Edge: Выберите верхнюю левую кромку на изометрическом виде (2)

Specify the Hole location: Укажите местоположение (3)

Enter the Distance from first Edge (highlighted) <0.4146>: Введите .5

Enter the Distance from second Edge (highlighted) <4.3456>: Введите 4.25

Select the first Edge: нажмите ENTER

Отверстие для крепления ручки взвода создано.

6. Нажмите ENTER для вывода диалогового окна Hole Feature (Элемент Отверстия).
Operation: C’bore

Termination: Blind

Placement: 2 Edges

Drill Size: Dia: Введите .2

Depth: Введите 1.0

PT Angle: Введите 180

C’Bore/Sunk Size: C’ Dia: Введите .3

C’Bore/Sunk Size: C’ Depth: Введите .1

Нажмите ОК.

7. Ответьте на запросы следующим образом:
Select the first Edge: Выберите верхнюю заднюю кромку на изометрическом виде

Select the second Edge: Выберите верхнюю левую кромку на изометрическом виде

Specify the Hole location: Укажите местоположение

Enter the Distance from first Edge (highlighted) <0.4146>: Введите .85

Enter the Distance from second Edge (highlighted) <4.3456>: Введите 1.6

Select the first Edge: нажмите ENTER

Отверстие для крепления кнопки спуска создано.
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Сохраните ваш файл.

Создание Элементов на Рабочей Плоскости
Корпус камеры закончен, за исключением элементов поверхности камеры. В отличие от
предыдущих элементов, Вы сделаете эскиз этих элементов на рабочей плоскости,
параллельной передней стороне камеры. Вы выдавите элементы в тело камеры на
требуемую глубину.

Вы сделаете эскиз на рабочей плоскости, потому что двухмерные эскизы не могут быть
нарисованы и спрофилированы на поверхности NURBS.

Объектив - полый цилиндр, присоединенный к поверхности камеры и имеющий два
элемента: твердотельный цилиндр и круг, используемый для вырезания центра
цилиндра.

Для выдавливания объектива на рабочей плоскости
1. Выберите один из следующих методов для создания новой рабочей плоскости на которой

размещается плоскость эскиза:

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Work Plane.

Пиктограмма Work Plane

Меню Desktop Design → Work Features → Work Plane

Команда AMWORKPLN

2. В диалоговом окне Work Plane Feature (Элемент Рабочей Плоскости) укажите:
1st Modifier: Planar Parallel

2nd Modifier: Offset

Offset: Введите 1.25

Create Sketch Plane: Включите переключатель и нажмите OK

3. Ответьте на запросы следующим образом:
Select work plane, planar face or [worldXy/worldYz/worldZx/Ucs]:

Укажите точку (1)

Enter an option [Next/Accept] <Accept>:

Нажмите ENTER, когда передняя поверхность подсветится

Enter an option [Flip/Accept] <Accept>:

Убедитесь, что рабочая плоскость находится на расстоянии от плоскости и
нажмите ENTER

Plane = Parametric
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Select Edge to align X axis or [Z-flip/Rotate] <accept>:

Убедитесь, что ось Z указывает от передней поверхности камеры и нажмите ENTER

Рабочая плоскость создана на передней поверхности камеры. Поскольку плоскость
эскиза определена на рабочей плоскости, пиктограмма UCS также отображается на
рабочей плоскости

4. На виде спереди, сделайте эскиз круга на передней поверхности камеры.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Circle.

Пиктограмма Circle

Меню Desktop Design → Circle → Center, Radius

Команда CIRCLE

5. Создайте профиль.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Single Profile.

Пиктограмма Single Profile

Меню Desktop Design → Sketch Solving → Single Profile

Команда AMPROFILE

Для позиционирования круга, Вам потребуются три размера или зависимости: диаметр и
два размера для размещения круга на плоскости эскиза относительно корпуса камеры.

6. Образмерьте эскиз по следующим значениям.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM
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7. В изометрическом виде, выдавите профиль для создания внешней поверхности корпуса
объектива.

Обозреватель  Щелкните правой кнопкой мыши по Profile6 и выберите Extrude.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Extrude.

Пиктограмма Extrude

Меню Desktop Part → Sketched Features → Extrude

Команда AMEXTRUDE

8. В диалоговом окне Extrusion (Выдавливание) укажите:
Operation: Join

Termination: Blind

Distance: Введите 1.25

Flip: Укажите направление стрелки внутрь корпуса камеры

Нажмите ОК.

Объектив закончен. Теперь, вырежьте цилиндр меньшего размера в объективе.

Для создания полости в объективе
1. Активизируйте вид спереди и нарисуйте круг на рабочей плоскости.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching → Circle.

Пиктограмма Circle

Меню Desktop Design → Circle → Center, Radius

Команда CIRCLE
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2. Создайте профиль.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Profile.

Пиктограмма Profile

Меню Desktop Design → - Sketch Solving → Profile

Команда AMPROFILE

Необходимы три размера или зависимости для определения эскиза.

3. Наложите зависимости на эскиз, чтобы сделать его соосным с объективом.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Concentric.

Пиктограмма Concentric

Меню Desktop Design → 2D Constraints → Concentric

Команда AMADDCON

4. Ответьте на запросы следующим образом:
Valid selection(s): arc, circle, or ellipse

Select object to be reoriented: Выберите меньший круг (1)

Valid selection(s): arc, circle, ellipse, or work point

Select object to be made concentric to: Выберите больший круг (2)

Valid selection(s): arc, circle, or ellipse

Select object to be reoriented: нажмите ENTER

Enter an option

[Hor/Ver/PErp/PAr/Tan/CL/CN/PRoj/Join/XValue/YValue/Radius/Length/Mir/Fix]

<eXit>: нажмите ENTER

5. Образмерьте эскиз в соответствии с указанными значениями.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM
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6. Сделайте изометрический вид активным и выдавите эскиз для создания полости в
объективе.

Обозреватель  Щелкните правой кнопкой мыши по Profile7 и выберите Extrude.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Extrude.

Пиктограмма Extrude

Меню Desktop Part → Sketched Features → Extrude

Команда AMEXTRUDE

7. В диалоговом окне Extrusion (Выдавливание) укажите:
Operation: Cut

Termination: Through

Flip: Укажите направление стрелки внутрь корпуса камеры

Нажмите ОК.

Сохраните ваш файл.

Затем, Вы создадите отсек видоискателя, прямоугольник со скругленными краями,
вырезанный в поверхности камеры.

Для вырезания отсека видоискателя
1. На виде спереди сделайте эскиз прямоугольника в плоскости эскиза выше объектива.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и выберите
2D Sketching → Rectangle.

Пиктограмма Rectangle

Меню Desktop Design → Rectangle

Команда RECTANG

2. Сопрягите углы прямоугольника.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching →  Fillet.

Пиктограмма Fillet

Меню Desktop Modify → Fillet

Команда FILLET
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3. Ответьте на запросы следующим образом:
Current settings: Mode = TRIM, Radius = 0.5000

Select first object or [Polyline/Radius/Trim]: Введите r

Specify Fillet radius <0.5000>: Введите .1

4. Нажмите ENTER для повторного вызова команды FILLET и ответьте на запросы
следующим образом:
Current settings: Mode = TRIM, Radius = 0.1000

Select first object or [Polyline/Radius/Trim]: Введите р

Specify Fillet radius <0.5000>: Укажите прямоугольник

5. Создайте профиль.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Single Profile.

Пиктограмма Single Profile

Меню Desktop Design → Sketch Solving → Single Profile

Команда AMPROFILE

Вам требуется еще пять или более размеров или зависимостей для определения эскиза.
Добавьте два размера для длины и ширины формы, один размер для скруглений и два
размера для позиционирования эскиза относительно корпуса камеры.

6. На виде спереди увеличьте изображение для показа модели.

8. Добавьте следующие размеры.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

8. Вырежьте эскиз из корпуса камеры.

Обозреватель  Щелкните правой кнопкой мыши по Profile8 и выберите Extrude.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Extrude.

Пиктограмма Extrude

Меню Desktop Part → Sketched Features → Extrude

Команда AMEXTRUDE
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7. В диалоговом окне Extrusion (Выдавливание) укажите:
Operation: Cut

Termination: Through

Flip: Укажите направление стрелки внутрь корпуса камеры

Нажмите ОК.

Последний элемент - отсек вспышки. Он имеет форму, подобную видоискателю, но он
больше и расположен в правом верхнем углу лицевой поверхности камеры.

Для вырезания отсека вспышки
1. Сделайте эскиз прямоугольника справа от видоискателя.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и выберите
2D Sketching → Rectangle.

Пиктограмма Rectangle

Меню Desktop Design → Rectangle

Команда RECTANG

 2. Сопрягите углы прямоугольника

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Sketching →  Fillet.

Пиктограмма Fillet

Меню Desktop Modify → Fillet

Команда FILLET

3. Ответьте на запросы следующим образом:
Current settings: Mode = TRIM, Radius = 0.5000

Select first object or [Polyline/Radius/Trim]: Введите r

Specify Fillet radius <0.5000>: Введите .1

4. Нажмите ENTER для повторного вызова команды FILLET и ответьте на запросы
следующим образом:
Current settings: Mode = TRIM, Radius = 0.1000

Select first object or [Polyline/Radius/Trim]: Введите р

Specify Fillet radius <0.5000>: Укажите прямоугольник
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5. Создайте профиль.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketch Solving → Single Profile.

Пиктограмма Single Profile

Меню Desktop Design → Sketch Solving → Single Profile

Команда AMPROFILE

Вам требуется еще пять или более размеров или зависимостей для определения эскиза.
Добавьте два размера для длины и ширины формы, один размер для скруглений и два
размера для позиционирования эскиза относительно корпуса камеры.

На виде спереди увеличьте изображение для показа модели.

6. Сделайте верхнюю и правую кромки коллинеарными верхнему правому углу отсека
пленки.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите 2D Constraints → Collinear.

Пиктограмма Collinear

Меню Desktop Design → 2D Constraints → Collinear

Команда AMADDCON

7. Добавьте следующие размеры.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → New Dimension.

Пиктограмма New Dimension

Меню Desktop Dimensioning → Dimensioning → New Dimension

Команда AMPARDIM

8. Выдавите эскиз, чтобы вырезать его из корпуса камеры.

Обозреватель  Щелкните правой кнопкой мыши по Profile9 и выберите Extrude.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Sketched & Work Features → Extrude.

Пиктограмма Extrude

Меню Desktop Part → Sketched Features → Extrude

Команда AMEXTRUDE

9. В диалоговом окне Extrusion (Выдавливание) укажите:
Operation: Cut

Termination: Through

Flip: Укажите направление стрелки внутрь корпуса камеры
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Нажмите ОК.

Сохраните ваш файл.

Изменение Конструкции
Как и со всеми проектами, конструкции изменяются в процессе разработки. Например,
Вы хотите отмасштабировать камеру до меньшего размера и изменить размер,
координирующий переднюю поверхность камеры в твердотельной модели. Поскольку Вы
хотите изменить поверхность и корпус камеры в одном масштабе, Вы сначала должны
изменить их размеры.

В этом упражнении, Вы укажите процент от текущего размера камеры. Затем, для
пропорционального позиционирования поверхности на камере, Вы измените
параметрический размер.

Для масштабирования корпуса и поверхности камеры
1. Увеличьте изометрический вид.

2. Измените размеры детали.

Меню Desktop Modify → Scale

Команда SCALE

3. Ответьте на запросы следующим образом:
Select Objects: Выберите камеру и нажмите ENTER

Select Objects: нажмите ENTER

Specify base point: Выберите задний угол камеры

Specify scale factor or [Reference]: Введите .9

Камера и поверхность уменьшатся до 90 процентов от их первоначального размера.
Поверхность и другие элементы сохранят их первоначальные взаимные расположения
плоскостей.
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Для изменения положения передней поверхности камеры
1. Отредактируйте элемент поверхности рассечения.

Обозреватель Щелкните правой кнопкой мыши по SurfCut1 и выберите Edit.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Edit Features → Edit.

Пиктограмма Edit Features

Меню Desktop Part → Edit Feature

Команда AMEDITFEAT

2. Ответьте на запросы следующим образом:
Enter an option [Independent Array instance/Sketch/surfCut/Toolbody/select

Feature] <select Feature>: Введите c

Select surfcut feature: Выберите криволинейную кромку поверхности

ОБРАТИТЕ ВНИМАНИЕ Если Вы используете Обозреватель, запросы не появляются.

Отображаются первоначальный эскиз, рабочая плоскость и рабочая точка.

3. Измените размер, который позиционирует поверхность по рабочей точке.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Dimensioning → Edit Dimension.

Пиктограмма Edit Dimension

Меню Desktop Design → Dimensioning → Edit Dimension

Команда AMMODDIM

3. Ответьте на запросы следующим образом:
Select Dimension to change: Выберите горизонтальный размер

New value for Dimension <.16>: Введите .75



Mechanical Desktop Tutorials Release 4

Глава 9  Комбинирование Деталей и Поверхностей 291

Select Dimension to change: нажмите ENTER

4. Обновите деталь.

Обозреватель Щелкните по пиктограмме Update Part.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Update Part

Пиктограмма Update Part

Меню Desktop Part → Update Part

Команда AMUPDATE

Поверхность переместилась в новое положение на камере.

Заключительные Построения
Для завершения корпуса камеры следует сгладить углы, где соприкасаются различные
стороны.

Для завершения корпуса камеры
1. Скройте видимость рабочей плоскости.

Обозреватель Щелкните правой кнопкой мыши по EXTRUDE_1 и выберите
Visible.

Пиктограмма Part Visibility

Меню Desktop Part → Part Visibility

Команда AMVISIBLE

2. В диалоговом окне Desktop Visibility выберите ярлычок Part и выберите Work Planes и
Hide. Нажмите ОК.

ОБРАТИТЕ ВНИМАНИЕ Если вы выбираете рабочую плоскость в Обозревателе,
диалоговое окно не появляется.

3. Используйте системную переменную ISOLINES для увеличения количества изолиний.
Увеличьте значение до 8, чтобы просмотреть модель более детально. Отображение
изменится, когда Вы отредактируете вашу модель.

4. Сгладьте корпус камеры.

Контекстное Меню В графической области, щелкните правой кнопкой мыши и
выберите Extrude Features  → Fillet.

Пиктограмма Fillet

Меню Desktop Design → Extrude Features  → Fillet

Команда AMFILLET
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5. В диалоговом окне Fillet (Скругление), укажите Constant (Постоянное) и используйте
радиус сопряжения .05. Вернитесь к кнопке Dialog и выберите Apply.

ОБРАТИТЕ ВНИМАНИЕ Для ускорения сопряжения сложной модели, выбирайте
небольшое количество обрабатываемых кромок за раз. Для обработки большого
количества кромок несколько раз используйте эту команду.

6. Сопрягите внешние  углы и кромки корпуса камеры. По завершении выберите Done.

Корпус камеры завершен
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